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Mimorámové	údaje	
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autoři listu: Jakub Jaroš, Jakub Lysák 

 

Cíle	

V tomto pracovním listu se student: 

– dozví, co jsou mimorámové údaje a jaké jsou obecné zásady pro správnou tvorbu mimorámových 

údajů čili kompozičních prvků mapy (legendy, měřítka, směrovky, názvu mapy atd.), 

– zjistí, jak je vytvářet v programu ArcGIS for Desktop, 

– získá další informace o v praxi používaných postupech a doporučeních týkajících se mimorámo-

vých údajů. 

Teorie	

Pod pojem mimorámové údaje [1] se zahrnují údaje umístěné vně rámu mapy, tedy mimo vlastní 

mapové pole. Z pohledu zažité kartografické terminologie lze pod tímto pojmem chápat jednotlivé 

kompoziční prvky mapy, které se nachází mimo vlastní mapové pole. 

Proč mimorámové údaje? V praxi často bývá mapové pole ohraničeno silnější čarou – rámem. Uvnitř něj je 

vlastní mapové pole a případné další doplňující informace mezi vnitřní a vnější rámovou čarou. Ostatní kom-

poziční prvky pak leží mimo tento rám. 

K základním kompozičním prvkům mapy, které by měly být součástí každé mapy, patří: 

– mapové pole, 

– název mapy, 

– legenda, 

– měřítko, 

– tiráž. 

Informační hodnotu mapy pak mohou zvyšovat nadstavbové kompoziční prvky, k nimž patří 

zejména směrovka, vedlejší mapová pole, textová pole, tabulky, obrázky, grafy, schémata, loga, rej-

stříky a seznamy atd. 

Většina těchto prvků je podrobněji popsána dále v textu. 

Při tvorbě mapy je důležitým úkolem vyřešit rozmístění jednotlivých kompozičních prvků 

na mapovém listu [2]. Prostor listu by měl být efektivně využit, tedy nikde by nemělo zůstat prázdné 

místo, ani by nemělo dojít k lokálnímu nahuštění nebo dokonce překrývání jednotlivých kompozič-

ních prvků. Mapové pole musí být na listu dominantním prvkem. Dále je vhodné respektovat zásady 

obecné grafické tvorby, zejména směr čtení obrazu z levého horního do pravého dolního rohu (název 

mapy, který se čte první, by tedy měl být umístěn nahoře), zásadu blízkosti a souvislosti (věci patřící 

logicky k sobě by měly být poblíž sebe) atd. Před vlastní tvorbou je tedy žádoucí kompozici mapy 

dobře rozmyslet (Obr. 1). Pomůže při tom maketa, což je grafický dokument, zobrazující v základních 
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rysech zamýšlenou mapu s jejím obsahem, grafickým provedením a mimorámovými údaji. Podrob-

nější informace o možném postupu při sestavení kompozice mapy lze nalézt v [3] na str. 178–179. 

 

 

Obr. 1. Ukázka zdařilé mapové kompozice: mapové pole je dominantní a ostatní kompoziční prvky jsou umís-

těny okolo něj tak, že nejsou v grafickém konfliktu a zároveň pokrývají celý mapový list. 

 

Legenda 

V odborné literatuře se často uvádí, že ideálně navržený znakový klíč by měl být natolik názorný 

a srozumitelný, aby mapa, v níž jsou znaky použity, byla snadno interpretovatelná i bez legendy. 

V praxi se však lze takovému návrhu pouze přiblížit, neboť proces čtení mapy je vždy subjektivní a je 

značně ovlivněn konkrétním uživatelem (jeho schopnostmi, zkušenostmi, znalostí mapovaného téma-

tu apod.). Správně zkonstruovaná legenda, umožňující bezchybné porozumění obsahu mapového 

pole, by proto měla být součástí každé mapy. 

Pokud bychom mapu přirovnali ke knize a definovali ji jako tištěné médium, které nám prostřed-

nictvím užitého jazyka předává zapsané (zakreslené) informace, pak bychom mohli legendu považo-

vat za jakýsi výkladový slovník. Obdobně jako v mluveném/psaném jazyce výkladový slovník definuje 

význam jednotlivých slov, legenda v mapě definuje význam kartografických znaků a barevných či veli-

kostních stupnic (Obr. 2). 
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Obr. 2. Ukázka legend obsahujících bodové znaky, velikostní a barevnou stupnici. 

   

Představení legendy jako mapového prvku určujícího souvislost mezi kartografickými vyjadřova-

cími prostředky a jejich významem může svádět k záměně pojmů legenda a znakový klíč. Tyto pojmy 

je však třeba jasně rozlišovat. 

Znakový klíč (viz Obr. 3) figuruje v procesu vytváření mapy a tvůrci map pomocí něj kódují (vklá-

dají) informaci o reálných objektech či jevech do kartografického znaku. Jinými slovy, na počátku 

tvorby znakového klíče je informace, kterou chce autor mapy do mapy vložit a na konci sada karto-

grafických znaků znakového klíče, které tuto informaci reprezentují a které jsou následně použity při 

sestavování mapy. Znaky jsou ve znakovém klíči jasně pojmenovány, je přesně popsán jejich význam 

a také konkrétní parametry jejich grafické podoby (šířka linie, barva, struktura apod.). 

Legenda mapy (viz Obr. 4) vychází ze znakového klíče. Na rozdíl od něj je však v podobě základní-

ho kompozičního prvku přímo součástí mapy a slouží čtenáři mapy k dekódování informace 

z použitých kartografických znaků. 

 

 

Obr. 3. Ukázka prvků silniční sítě ze znakového klíče Základní mapy 1 : 25 000. 
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Obr. 4. Ukázka legendy pro železniční síť. 

 

Zásady pro tvorbu legendy 

Zpracování správné legendy vyžaduje dodržení čtyř základních zásad. Tyto zásady vyžadují, aby byla 

legenda mapy (1) úplná, (2) uspořádaná, (3) v souladu s mapovým polem, a v neposlední řadě aby 

byla (4) použitelná a srozumitelná.  

1. Úplnost 

Zásadu úplnosti nejlépe vystihuje tvrzení, že „veškeré znaky, barevné stupnice apod., které jsou 

použity v mapovém poli, musí být obsaženy také v legendě“. Stejně tak platí i opačné tvrzení, 

tedy že se „všechny položky legendy, musí aspoň jednou nacházet také v mapovém poli“. Vý-

jimku tvoří v tomto smyslu matematické prvky (např. souřadnicová síť), které se v legendě 

standardně neuvádí. Druhou výjimkou je topografický podklad na tematických mapách. Ten je 

však možné vypustit pouze v případě, že není přímo svázán s tématem mapy a zároveň je zpra-

cován dostatečně názorně a srozumitelně, aby nemohlo dojít k jeho chybné interpretaci.  

Se zásadou úplnosti souvisí také uvádění popisu do legendy. Pokud je popis v mapovém poli 

graficky rozlišen (například velikostí písma) a lze tudíž očekávat, že je nositelem určitého vý-

znamu, je jeho umístění do legendy nutností. Jako příklad lze uvést popis sídel, který se graficky 

liší dle příslušného počtu obyvatel (Obr. 5, vlevo). Jiným příkladem může být popis vodních to-

ků, který je zpracován různou velikostí písma v závislosti na průtoku či šířce znázorňovaného 

toku. Je-li nějaký popis v mapovém poli vázán na konkrétní kartografický znak, pak se běžně 

tento znak uvádí do legendy i s popisem (viz Obr. 5, vpravo). V takovém případě je vhodné, aby 

se v legendě objevil některý ze znaků (a popisků), které se skutečně nachází v mapovém poli 

(pokud tedy vytváříme mapu Jeseníků, vložíme do legendy pro kótovaný bod „Praděd“ a nikoliv 

„Sněžku“). 

   

Obr. 5. Vlevo popis rozlišený dle počtu obyvatel v sídle, vpravo popis vázaný na kartografický znak. 
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2. Uspořádanost 

Uspořádanost legendy se na mapách projevuje dvěma způsoby. Zaprvé je třeba zajistit, aby 

znaky v legendě byly sdruženy do skupin dle charakteru prvků, jež reprezentují. Například pra-

men, vodopád, vodní tok, vodní plocha a kanál budou v legendě začleněny do stejné skupiny, 

neboť všechny prvky spadají do kategorie „vodstvo“. Ukázka uspořádané legendy je na Obr. 6. 

V rámci každé takového kategorie lze pak dále rozlišovat tři podskupiny odrážející geometrickou 

povahu znaků. Tedy znaky bodové, liniové a areálové. Znaky spadající do stejné podskupiny by 

měly být vždy řazeny za sebou. 

Další nároky na uspořádanost jsou kladeny na tematické mapy, u kterých platí, že znaky týkající 

se přímo tématu, jsou řazeny v úvodu legendy. Logickým důsledkem tohoto řazení je, že topo-

grafický podklad se u tematických map umisťuje na konec či je, za splnění podmínek uvedených 

výše v textu, zcela vynechán. 

 

 

Obr. 6. Uspořádaná legenda. 

 

3. Soulad s mapou 

Podstata této zásady je zřejmá již z názvu. Veškeré znaky obsažené v legendě musí mít naprosto 

stejnou podobu, jakou mají v mapovém poli. Jakékoliv rozdíly ve velikosti, barvě, hustotě rastrů 

či dalších parametrech nejsou akceptovatelné. Ani pokud je legenda natolik obsáhlá, že se ne-

vejde na mapový list, není změna velikosti znaků přípustná a je třeba uzpůsobit kompozici, pří-

padně velikost mapového listu. 

V souvislosti s touto zásadou lze uvést také několik konkrétních doporučení. V případě, že 

některý areálový znak obsahuje liniový rastr, je nutné, aby pole s rastrem v legendě obsahovalo 

aspoň dvě linie rastru a bylo jednoznačně možné stanovit rozestup linií (viz Obr. 7). U rastrů slo-

žených z bodů je třeba opět zajistit, aby bylo z legendy zřejmé, že se jedná o rastr. Uvedení je-

diného bodu je tedy zcela nepřípustné, neboť může dojít k záměně se samostatným bodovým 

znakem (viz Obr. 7). Obdobně je třeba postupovat v případě přerušovaných linií, u kterých by se 

v legendě měly objevit aspoň dva celé segmenty linie (viz Obr. 7). 
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K častým chybám pak dochází u areálových znaků. Pokud součástí areálového znaku 

v mapovém poli výplň i obrys, je nutné, aby i ukázka znaku v legendě obsahovala jak výplň, tak 

obrys. Používáme-li naopak při konstrukci kartografického znaku pouze výplň, nesmí být sou-

částí znaku v legendě žádný obrys. Typickým příkladem chybné legendy je legenda k barevné 

hypsometrii, kdy se pro vyjádření výškových pásem v mapovém poli užívá pouze barevné výpl-

ně areálů, ale v legendě jsou barevné plošky ohraničené. 
 

 

Obr. 7. Ukázka chybně (nahoře) a správně (dole) zpracovaných znaků s jejich významem v legendě pro znaky 

vyplněné rastrem či tvořené přerušovanou linií. Příklad s rozvodnicí vychází z předpokladu, že znak 

pro rozvodnici je tvořen přerušovanou linií se stejně dlouhými segmenty. 

 

 
 

Obr. 8. Ukázka barevné hypsometrie, chybné a správné legendy. Z ukázky je zřejmé, že jednotlivé výškové 

stupně nejsou ohraničeny černou linií a proto nesmí černá linie ohraničovat ani barevná pole v legendě. 

  

4. Použitelnost a srozumitelnost 

Při sestavování legendy by se mělo vždy postupovat tak, aby byla legenda přehledná a efektivně 

použitelná. Textová část legendy by proto měla být psána jednoduše, a pokud to téma mapy vy-

loženě nevyžaduje, tak bez užívání dlouhých spojení a cizích výrazů. Popisy významů standard-

ně začínají malým písmenem (podobně jako v cizojazyčném slovníku) a jsou vhodně zarovnány. 

Dále je doporučeno nenadepisovat legendu slovem „LEGENDA“. Výjimkou jsou pouze rozsáhlá 

mapová díla či atlasy, kde legenda tvoří samostatnou kapitolu, nejčastěji v přední části publika-

ce, nebo je k mapě připojena jako externí příloha. Jiné nadpisy jako „VYSVĚTLIVKY“, „KLÍČ“ 

apod. nelze akceptovat nikdy.  

Vysvětlení významu prvků by mělo být také logické. Pokud je tedy znakem v mapě repre-

zentován jeden výskyt daného objektu či jevu, měl by být i popisný text v legendě v jednotném 

čísle. Obdobné doporučení platí pro číslo množné. Znaky pro přírodní objekty by měly být 

v legendě znázorněny nepravidelným tvarem odrážejícím tvarová specifika reálného objektu 

(vlnovka namísto lomené linie pro řeku, nepravidelný oblý tvar namísto obdélníku pro vodní 

plochu apod.). Stejně tak pro znaky uměle vytvořených objektů je vhodnější tvarově pravidelná 

reprezentace (intravilán obdélníkem či „pravoúhelníkem“). K častým chybám dochází také při 

znázorňování hranic areálů, které jsou v legendě reprezentovány uzavřeným polygonem namís-

to linie.  
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Pokud mapa obsahuje vrstevnice či jiné izolinie, musí být součástí legendy uvedení jejich in-

tervalu. Tuto informaci lze vložit přímo do popisu významu příslušné linie nebo jako samostat-

nou textovou informaci. 

Je-li legenda součástí stejného mapového listu jako mapové pole, snažíme se o umístění le-

gendy (společně se seznamem zkratek a vysvětlivek) poblíž mapového pole. 

Často je mezi zásady pro tvorbu legendy uváděna také nezávislost. Různí autoři v rámci odborné 

literatury uvádějí, že nezávislost legendy je zaručena tehdy, pokud obsahuje pouze znaky, které jed-

noznačně vyjadřují prvky obsahu mapy. Nezávislost legendy je pak porušena v případě, pokud lze 

jednomu jevu v mapě přiřadit dva různé kartografické znaky v legendě, např. les a listnatý les (viz 

například [3], s. 158). 

Skutečností však je, že porušení nezávislosti, je problémem chybného návrhu znakového klíče 

a protože legenda z mapového klíče přímo vychází, nelze již ve fázi jejího sestavování tento problém 

nijak ovlivnit. O vzájemné nezávislosti kartografických znaků je tedy třeba uvažovat již při návrhu 

znakového klíče a ne až při sestavování legendy.  

Zásady pro tvorbu legendy jsou platné při tvorbě jakýchkoliv map, včetně digitálních. U digitálních 

map může být sestavení správné legendy obzvláště náročné, neboť jejich obsah lze často měnit inter-

aktivně změnou měřítka. V takovém případě je třeba zajistit, aby se veškeré změny znakového klíče, 

které jsou především výsledkem generalizace, projevily též v legendě. Obvyklé je tedy fungování více 

variant legendy pro jednotlivá měřítka příslušné mapy. 

Měřítko 

Měřítko je poměr zmenšení zobrazovací plochy při konstrukci mapy. Měřítko tedy nemusí nutně 

znamenat v očích laiků zažitou informaci o tom „kolik centimetrů na mapě je kolik centimetrů 

ve skutečnosti“, protože neexistuje kartografické zobrazení, které by bylo ve všech částech mapy 

a směrech délkojevné. Uvedený údaj tak platí – zvláště pak u map malých měřítek – pouze v určitém 

směru nebo v určité části mapy. U map velkých měřítek je výše uvedené zjednodušení pro praktické 

účely akceptovatelné, protože chyba vyplývající z délkového zkreslení u v praxi používaných kartogra-

fických zobrazení je typicky menší než přesnost, se kterou jsme schopni vzdálenost měřit přímo 

v  mapě. Z výše uvedeného vyplývá, že na mapách velkých měřítek musí být měřítko uvedeno vždy. 

V případě map malých měřítek má uvedení měřítka smysl pouze tehdy, je-li uvedeno, v jaké části 

mapy je měřítko platné a ideálně také spolu s informací o kartografickém zobrazení, ve kterém byla 

mapa zhotovena. Matematickým pozadím měřítka a jeho vztahu ke zkreslení se zabývá obor mate-

matická kartografie a podrobnější informace lze čerpat například z [6]. V tomto textu se budeme dále 

zabývat pouze grafickou podobou měřítka. Text je zpracován převážně s využitím článku [4], kde lze 

nalézt další informace. 

Měřítko mapy se jako kompoziční prvek vyjadřuje nejčastěji v grafické a číselné podobě, případně 

také slovně.  

Grafické měřítko představuje úsečku s vyznačením délkových úseků. Skládá se z měřítkové linie 

(úsečky), příčných čárek (vynášecích čar) a popisu (číselných hodnot), viz Obr. 9. Velkou výhodou 

grafického měřítka je, že zůstává (na rozdíl od číselného a slovního) zachováno i při případném zvět-

šení nebo zmenšení mapy při její reprodukci. Z tohoto důvodu může být vhodné zvláště 
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u velkoformátových map používat pouze měřítko grafické, protože u nich je poměrně pravděpodob-

né zmenšování nebo tisk jejich zmenšených částí. 
 

 

Obr. 9. Typická podoba grafického měřítka, tvořeného měřítkovou linií, příčnými čárkami a jejich popisem. 

 

Délku grafického měřítka je třeba volit tak, aby odpovídalo mapě a dále tak, aby zobrazené hod-

noty vzdálenosti byly dekadické (100 m, 500 m, 1 km, 5 km, 10 km atd.). Při tom není podstatné, zda 

bude měřítková linie dlouhá zaokrouhlený počet centimetrů. Je třeba splnit ovšem další omezující 

podmínku, a to aby měřítková linie nebyla příliš dlouhá. Měřítko je totiž kompoziční prvek, který by 

měl být viditelný až při blízkém pohledu na mapu a neměl by tedy na sebe poutat příliš pozornost 

(například tím, že zabírá polovinu šířky stránky). 

Při měřítku 1 : 120 000 000 je tedy lepším řešením vytvořit úsečku dlouhou 4,17 cm představující 

délku 5 000 km spíše než úsečku dlouhou 6 cm představující délku 7 200 km. Smyslem tohoto opat-

ření je, aby se daly dobře odhadovat (příp. měřit) vzdálenosti v mapě, k čemuž je užitečnější zao-

krouhlená hodnota délek v kilometrech spíše než okrouhlá délka úsečky. 

 

  

Obr. 10. Hlavní a vedlejší dělení. Vlevo hlavní dělení vyjádřené příčnými čárkami s popisem, vedlejší dělení 

černými a bílými segmenty. Vpravo hlavní dělení vyjádřené delšími příčnými čárkami s popisem, vedlejší 

dělení kratšími čárkami. 

 

Vhodným doplněním grafického měřítka je zjemnění jeho části pomocí dílčích dělení (Obr. 9, Obr. 

10). Rozlišuje se hlavní dělení a vedlejší dělení. Příčné čárky hlavního dělení jsou obvykle delší a jsou 

popsány délkovým údajem, příčné čárky vedlejšího dělení bývají kratší a nejsou popsány vůbec. Ve-

dlejší dělení lze vyjádřit například i rozdělením měřítkové linie na černobílé segmenty. Pro hlavní 

i vedlejší dělení by měla platit zásada dekadičnosti podobně jako pro délku celé úsečky. 

Při měřítku 1 : 120 000 000 je tedy lepší úsečku dlouhou 4,17 cm představující délku 5 000 km rozdělit 

na 5 dílů po 0,83 cm s tím, že každý dílek představuje 1 000 km, než ji rozdělit v polovině na dva segmenty 

odpovídající 2 500 km a následně v rámci vedlejšího dělení na segmenty po 1 250 km. 

 

Z hlediska grafického zpracování se doporučuje vyvarovat se příliš dlouhých příčných čárek, aby 

výsledný tvar nepůsobil dojmem „hrábí“ či dokonce „vidlí“. Číselné hodnoty jsou vzhledem k čárkám 

hlavního dělení zarovnané na střed (Obr. 11). Měřítko začíná vlevo hodnotou 0 (nula) a podle středo-

evropských kartografických zvyklostí jsou jednotky umístěny vpravo za posledním číslem a odsazeny 
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mezerou. Jednotky nejsou součástí zarovnání poslední číselné hodnoty k odrážce, ale zůstávají za ní. 

Příčné čárky vybíhají z měřítkové linie jedním směrem k číselným hodnotám (obdobně jako 

v technických výkresech při kótování) a nekříží tedy osu.  

 

Obr. 11. Zarovnání číselných hodnot vzhledem k příčným čárkám hlavního dělení a jednotkám. 

 

V případě, že má mít měřítko pouze orientační charakter, lze dělení zcela vynechat (Obr. 12). To 

je případ přehledových map nebo obecně všech map malého měřítka, kde měřítko slouží k získání 

informace o přibližných rozměrech zobrazeného území a nikoliv k přesnému měření vzdáleností. 

V tomto případě se hodnota délky i s jednotkami umisťuje zarovnaná na střed nad úsečku. Úsečka by 

měla délku textu mírně přesahovat, aby bylo zřejmé, že jde o měřítko a ne například o podtržení tex-

tu. 

 

Obr. 12. Ukázka možné podoby měřítka orientačního charakteru. 

 

Číselné měřítko se uvádí ve formě 1 : M, kde M je měřítkové číslo. Okolo dvojtečky jsou (zúžené) 

mezery. Měřítkové číslo by mělo být dostatečně zaokrouhlené, tedy zjednodušeně řečeno číslo 

s velkým počtem nul na konci. Je tedy přípustné měřítkové číslo mírně zaokrouhlit, protože 

s ohledem na grafickou přesnost mapy a chyby vyplývající z nedélkojevnosti zobrazení ve všech smě-

rech nedojde k významnější chybě.  

Umisťujeme-li na mapu zároveň měřítko grafické a číselné, mělo by být číselné měřítko na opačné 

straně měřítkové linie než popis hodnot grafického měřítka (tedy typicky pod měřítkovou linií, viz 

Obr. 13). Zabráníme tím nechtěné záměně měřítkového čísla za vzdálenost patřící k některému 

z hlavních dělení.  

 

Obr. 13. Vzájemná poloha popisu grafického měřítka a číselného měřítka. 
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Slovní měřítko se používá v praxi spíše výjimečně, má obvykle podobu 1 cm = 100 m nebo 1 cm 

na mapě odpovídá 100 metrům ve skutečnosti. Určitý praktický význam má například u pohledových 

map, blokdiagramů a podobných prostorovým mapám příbuzným zobrazením, které mají s ohledem 

na použití perspektivy měřítko proměnlivé. V těchto případech má slovní měřítko podobu popisu 

vzdálenosti mezi dvěma zobrazenými objekty v mapě: Vzdálenost Milešovky a Sedla je 24 km.  

Směrovka 

Směrovka (též směrová růžice) je kompoziční prvek, označující na mapě vhodným způsobem směr 

k severu.  

Označení severka, používané často pro směrovku laiky, není úplně vhodné, neboť mapy nemusí být striktně 

orientovány k severu a směrovka může ukazovat případně i k jiné světové straně. 

Aby dávalo smysl směrovku použít, musí být směr v severu v celé mapě téměř konstantní. 

Z tohoto pohledu dává smysl směrovku použít pouze na mapách velkých, příp. středních měřítek, kde 

je tento předpoklad splněn. Směrovku lze vynechat v situaci, kdy je mapa orientovaná k severu (sever 

je z pohledu orientace stránky nahoře) a zároveň znázorňuje všeobecně známé území (mapa Česka 

vytvořená v češtině, určená převážně pro čtenáře v Česku).  

Grafický vzhled směrovky by měl být přizpůsoben celkovému vzhledu mapy, obvykle je tedy 

na místě zachování jednoduchosti směrovky spíše než užití složitých historizujících ornamentů. Smě-

rovka je vždy v jazyce mapy, na mapě vytvořené v češtině tedy nebude N (jako north) ale S (jako se-

ver). Směrovka by měla v rámci mapové kompozice působit spíše nenápadně, a tomuto požadavku je 

vhodné přizpůsobit její velikost. Umisťuje se obvykle mimo vlastní mapové pole. 

V řadě současných děl se objevuje nadužívání směrovky, případně její chybné použití (viz napří-

klad [2] nebo [5]). Na mapě malého měřítka je vhodnějším způsobem pro vyjádření orientace k seve-

ru použití zeměpisné sítě, protože směr k severu je (krom válcových zobrazení v normální poloze) 

v každém místě mapy jiný a odlišnosti ve směru mohou být značné. Alternativou je použití křížků 

na průsečících rovnoběžek a poledníků. Podobně u map Česka v Křovákově zobrazení není správné 

umístit směrovku otočenou o 7° po směru hodinových ručiček, protože to neodpovídá skutečnosti 

(správný směr je od 4,5 stupně na východě území našeho státu po téměř 10 stupňů na západě). Lepší 

řešení v tomto případě představuje použití takového zobrazení, kde tento problém nenastává (kon-

krétní doporučení viz [5]). 

Název mapy 

Název mapy je nápadný kompoziční prvek, ze kterého by mělo být zřejmé, co mapa znázorňuje. 

U map s topografickým obsahem zpravidla postačí uvést název zobrazovaného území, jelikož se jedná 

o konvenční druh map . U tematické mapy by však neměl chybět údaj, CO mapa zobrazuje (tedy té-

ma), KDE (jaké území) a, pokud je to relevantní, tak také KDY (údaj o časovém vymezení; neuvádí se 

u jevů bez významné časové proměnlivosti). Název mapy by měl být stručný, výstižný, jednoznačný 

a samozřejmě věcně a gramaticky správný. Název by neměl obsahovat slovo „mapa“ s tím, že výjim-

kou jsou konvenční tematické mapy – např. „Geologická mapa Slovenska“. Pokud název musí být 

delší, bývá zvykem rozdělit jej na titul (téma mapy) a podtitul (zbytek údajů). Podtitul je pak méně 

nápadný než titul (podtitul menším písmem, případně bývá zvykem titul psát VERZÁLKAMI a/nebo 
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tučně). Protože podtitul není větou, nezačíná velkým písmenem a nekončí tečkou. Název mapy se 

obvykle umisťuje poblíž jejího horního okraje a pro jeho lepší čitelnost je vhodné použít bezserifové 

(bezpatkové) písmo.  

Tiráž 

Tiráž by měla obsahovat jméno autora či vydavatele mapy a místo a rok vydání. Jde o nenápadný 

prvek, umístěný obvykle u spodního okraje mapy. Je-li to účelné, lze uvést další údaje jako výše ná-

kladu, pořadí vydání, atd. Součástí tiráže by – zvlášť u map s odborným obsahem – měl být seznam 

zdrojů dat, z nichž bylo při tvorbě mapy čerpáno. Neuvedení zdrojů dle platných citačních norem lze 

považovat za hrubé porušení citační etiky. 

Vedlejší mapové pole 

Součástí mapového díla mohou být také další mapy, typicky rozměrově výrazně menší než hlavní 

mapové pole. Mají obvykle následující podobu a význam: 

– lokalizační (přehledné) mapy – zobrazují území znázorněné na hlavním mapovém poli v širším 

kontextu, například polohu dané lokality v rámci státu, kontinentu apod. Smyslem je dát čtenáři 

mapy lepší představu o tom, kde se – v rámci všeobecně známého území – daná lokalita nachází. 

Použití těchto map se řídí okruhem potenciálních uživatelů mapy. Pro mapu určenou pro české 

prostředí je zbytečné vytvářet lokalizační mapu Česka s umístěním Krkonoš, pro článek do mezi-

národního časopisu je naopak na místě polohu Krkonoš v rámci Evropy i Česka vyznačit, 

– výřezy – zobrazují výřez hlavní mapy ve větším měřítku typicky v místech, kde jsou znázorněné 

jevy příliš nahromaděné, a hlavní mapové pole je lokálně příliš zaplněné nebo jsou z něj některé 

údaje vynechány. Smyslem výřezu je taková místa zachytit přehledněji. Typickou ukázkou je výřez 

detailu historického centra na plánu města. 

– doplňkové tematické mapy – používají se v tematické kartografii situaci, kdy hlavní tematická 

mapa má komplexní charakter (vyjadřuje související jevy tvořící logický celek, např. zemědělství 

v Česku). Doplňkové mapy pak mohou zachycovat jednotlivé jevy samostatně (v podobě map 

analytického charakteru, např. hektarové výnosy pšenice za okresy), a to buď přímo ty, které jsou 

součástí hlavní mapy, popřípadě i jiné, pokud souvisí s tématem. 

Další doplňkové kompoziční prvky 

Mezi další doplňkové kompoziční prvky patří zejména tabulky, grafy, obrázky a textová pole. Pro je-

jich provedení platí nejen pravidla českého pravopisu, ale také obecné stylistické, typografické 

a grafické zásady. V rámci mapy je vhodné udržovat konzistentní grafický styl a nepodlehnout poku-

šení využít všech barev a fontů, které software nabízí. 
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Praktická	realizace	v	ArcGIS	for	Desktop	

 

Mimorámové údaje vložíme do mapového pole po přepnutí do režimu zobrazení výkresu (Layout 

View) pomocí volby View > Layout a následné volbě možnosti Insert a v ní výběru konkrétního typu 

kompozičního prvku: 

 

Legenda	

Automaticky vygenerovanou legendu pro aktuálně vybraný datový rámec (Data Frame) vložíme po-

mocí Insert > Legend. 

Prostřednictvím okna Legend Wizard (Obr. 14), postupně zadáme základní parametry a na závěr 

necháme legendu vygenerovat. Veškeré zadané parametry lze přitom editovat i dodatečně, 

a vygenerovaná podoba legendy tudíž nemusí být definitivní. 

 



 
Tento výukový materiál vznikl v rámci projektu Moderní geoinformační metody ve výuce GIS, 13 
kartografie a DPZ na Přírodovědecké fakultě Univerzity Karlovy v Praze v roce 2016. 

 

 

Obr. 14. Okno Legend Wizard. 

 

V prvním kroku dominují oknu Legend Wizard dva seznamy položek, Map Layers  a Legend Items. 

Přesunem položek z prvního seznamu do druhého vybereme ty datové vrstvy, jejichž symbolizace 

bude obsažena v legendě. Vždy je nezbytné naplnit požadavek úplnosti legendy. Tedy, aby byly 

všechny znaky použité v mapovém poli, v legendě vysvětleny. Kromě samotného výběru zde můžeme 

ovlivnit také pořadí znaků a počet sloupců, do kterých bude legenda graficky rozdělena – tedy uspo-

řádání legendy. 

Druhý krok slouží k vytvoření nadpisu legendy. S odkazem na informace uvedené v teoretické čás-

ti pouze uveďme, že není vhodné nadepisovat legendu slovem „Legenda“. Na mapách v českém jazy-

ce je pak zcela nepřípustné automaticky navržený nadpis „Legend“. Pokud zadání vytvářené mapy 

přímo nevyžaduje užití nadpisu, lze text nadpisu smazat. Druhou variantou je ponechat libovolný text 

a při dalších úpravách legendy (viz dále) nadpis skrýt. 

Třetí krok je věnován orámování. Přestože se s orámováním legendy lze setkat jen zřídka, existují 

situace, kdy může být toto grafické ozvláštnění na místě. ArcGIS nám kromě volby rámu dává navíc 

možnost obarvit pozadí, na kterém je legenda umístěna, opatřit rám různě barevným stínem či zaob-

lit jeho rohy. Takováto grafická zvýraznění je přitom možné aplikovat nejen na legendu, ale také 

na ostatní kompoziční prvky mapy. S grafikou tohoto typu je však vhodné šetřit, neboť často platí, že 

její nadužívání vizuální atraktivitu výsledku spíše snižuje.  

Ve čtvrtém kroku lze stanovit velikost výřezů, jimiž budou v legendě reprezentovány liniové 

a areálové znaky. Rozměry se zadávají v typografických bodech (1 typografický bod [pt] = 0,3528 mm) 

a jsou aplikovány pouze na datové vrstvy, které jsou právě vybrány. Jednotlivým vrstvám zde lze při-

řadit také tvar, kterým bude kartografický znak v legendě znázorněn/vykreslen. Nabídka programu 

ArcGIS je dostatečně pestrá, aby bylo možné zvolit vhodný tvar jak prvkům/objektům přírodního 
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původu (vodní plocha, vodní tok, vrstevnice atd.), tak prvkům/objektům vytvořeným uměle (hranice, 

elektrické vedení, zastavěné plochy atd.). 

V posledním kroku definujeme mezery mezi jednotlivými částmi legendy (opět v typografických 

bodech) a tlačítkem Dokončit legendu vygenerujeme (Obr. 15). 

 

 

Obr. 15. Automaticky vygenerovaná legenda. 

 

Vygenerovaná legenda představuje výchozí stav, který je nezbytné dále upravit do kartograficky 

akceptovatelné podoby. Z Obr. 15 je zřejmé, že textová část legendy reflektuje pojmenování jednotli-

vých datových vrstev, resp. odpovídá popiskům (Labels), které jsou jednotlivým vrstvám přiřazeny. 

Editaci popisků lze provést v tabulce obsahu (Table of Contents) nebo ve vlastnostech datové vrstvy 

(Layer Properties), kde na kartě General měníme jméno celé datové vrstvy a na kartě  Symbology 

jména jednotlivých typů objektů, pokud jsou objekty ve vrstvě dále rozlišeny (např. ve vrstvě doprav-

ní komunikace mohou být rozlišeny dálnice, rychlostní silnice a silnice). 

Rozdělení kartografických znaků podle datových vrstev také vytváří jednotlivé logické blo-

ky/úrovně legendy. Z toho vyplývá, že správný návrh datových vrstev, usnadní mimo jiné i vytvoření 

uspořádané legendy.  

Pokud legenda stále neodpovídá naším požadavkům, lze její podobu dále ovlivnit v okně Legend 

Properties (Obr. 16). Okno zobrazíme kliknutím na legendu pravým tlačítkem a výběrem položky Pro-

perties ze zobrazeného kontextového menu. 
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Obr. 16. Karta Items v okně Properties. 

 

Na kartě General můžeme skrýt nevhodný nadpis legendy a upravit výběr a pořadí datových vrs-

tev, jejichž kartografické znaky jsou v legendě obsaženy. Aktivací zaškrtávacích políček lze dále nasta-

vit, aby se legenda automaticky synchronizovala s tabulkou obsahu. 

Pomocí karty Items jsme schopni přizpůsobit vzhled jednotlivých částí legendy. Je třeba mít 

na paměti, že provedené úpravy jsou aplikovány vždy jen na znaky z datových vrstev, jež jsou vybrány 

z uvedeného seznamu. Výběr více vrstev lze provést standardně pomocí klávesy Ctrl, případně Shift.  

Tlačítkem Style vyvoláme okno s nabídkou předdefinovaných stylů legendy (Obr. 17). Pokud by 

nám žádný ze stylů nevyhovoval, můžeme kliknutím pravým tlačítkem na jednu konkrétní vrstvu vy-

volat okno Properties a uzpůsobit vzhled každé vrstvy zvlášť. Na kartě Arrangement vybíráme 

z různých uspořádání legendy. Úpravou parametrů karty General určujeme, které texty se mají 

u konkrétních kartografických znaků objevit a jakým tvarem a velikostí by v legendě měly být liniové 

a areálové znaky reprezentovány. 
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Obr. 17. Okno Legend Item Selector vyvolané tlačítkem Style. 

 

Časté využití nalezne i možnost volby vlastního písma pro texty v legendě, které se také edituje 

na kartě Items. 

Karty Layout a Frame sdružují funkce pro editaci mezer mezi jednotlivými částmi legendy 

a úpravy rámu. S nastavením těchto parametrů jsme se již seznámili během generování legendy 

(v okně Legend Wizard). Jedinou novinkou, je na kartě Layout parametr Fitting Strategy, pomocí kte-

rého dokáže software automaticky přeskupit legendu podle velikosti oblasti, která je legendě vyme-

zena. 

Pokud jsme upravili veškeré dostupné parametry a stále nejsme s podobou legendy spokojeni, je 

možné převést veškeré elementy, z nichž je legenda složena, na soubor grafických prvků a textových 

polí. Převedení se provádí volbou Convert to Graphics, která je dostupná v kontextovém menu, jež 

vyvoláme kliknutím pravým tlačítkem do prostoru legendy. Po konverzi jsou grafické prvky a texty 

stále sloučeny do společných celků a pro jejich další editaci je nutné tyto celky rozložit příkazem Un-

group. Ungroup lze aplikovat na jeden či více označených celků. Příkaz se nachází opět v kontextovém 

menu vyvolaném pravým tlačítkem. 
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Obr. 18. Výsledná podoba legendy. Po převedení na grafiku došlo k přidání nadpisů a finálnímu uspořádání 

jednotlivých částí legendy. 

 

Po převedení legendy na grafiku je možné libovolně měnit velikost a umístění jednotlivých částí 

(Obr. 18). Dodatečně lze měnit také obsah vygenerovaných textových polí. Legenda je však převede-

ním na grafiku ztrácí propojení s mapovým polem. Jinými slovy platí, že pokud po převedení legendy 

na grafiku změníme některý ze znaků v mapovém poli, tato změna se již v legendě neprojeví a je ne-

zbytné generovat legendu pro daný znak znovu. Proto je dobré převádět legendu na grafiku pouze, 

pokud je to nezbytně nutné a navíc vždy až ve chvíli, kdy jsme si jisti, že se znakový klíč již nebude 

měnit. 

Měřítko 

Grafické měřítko pro aktuálně vybraný datový rámec vložíme pomocí Insert > Scale Bar. Tato volba 

spustí průvodce, v němž v dalším kroku v okně Scale Bar Selector vybereme měřítko nejlépe odpoví-

dající našim představám a volbu potvrdíme klepnutím na OK. Tím se grafické měřítko vloží 

na stránku. Klepnutím pravým tlačítkem na měřítko a volbou Properties otevřeme dialogové okno 

Scale Line Properties (Obr. 19), kde lze řadu vlastností měřítka upravit. 
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Obr. 19. Dialogové okno Scale Line Properties, záložka Scale and Units. 

 

Na záložce Scale and Units můžeme v rámečku Scale změnit počet hlavních (Number of divisions) 

a vedlejších dělení (Number of subdivisions), případně nastavit oboustranné měřítko zaškrtnutím 

políčka Show one division before zero a nastavit, co se má dít s měřítkem, pokud měníme jeho veli-

kost jako grafického prvku.  

V rámečku Units specifikujeme v rozbalovacím seznamu Division Units, jaké budou jednotky děle-

ní (na české mapě metry nebo kilometry), v Label Position nastavíme, kde budou jednotky umístěny 

(typicky použijeme volbu after labels), v poli Label je definováno, jak bude daná jednotka popsána 

a do pole Gap lze zadat velikost odsazení jednotek od popisu. Jazyk, ve kterém jsou jednotky uvede-

ny, odpovídá vždy jazyku celé mapy (na českých mapách jsou upřednostňovány zápisy dle jednotek 

soustavy SI, akceptovatelné jsou tedy zápisy m či km, nikoliv Meters či Kilometers, a už vůbec ne Mi-

les). 

V praxi obvykle měřítko výsledné mapy známe. Postupujeme typicky tak, že zadáme údaje v části 

Units, potvrdíme je, upravíme šířku grafického objektu měřítka tak, aby nebylo příliš nápadné 

a zároveň zobrazené jednotky hlavního dělení byly dekadické, a v dalším kroku podle toho dořešíme 

počet hlavních a vedlejších dělení. 
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Obr. 20. Dialogové okno Scale Line Properties, záložka Numbers and Marks. 

 

Na záložce Numbers and Marks (Obr. 20) lze nastavit vlastnosti číselných hodnot a příčných čá-

rek. V rámečku Numbers se z rozbalovacího seznamu Frequency vybírá, kde mají být číselné hodnoty 

umístěny. Užitečné jsou zejména možnosti ends (and zero), kdy jsou číselné hodnoty umístěny 

na prvním a posledním hlavním dělení, divisions, kdy jsou popsána všechna hlavní dělení, a single 

label pro orientační měřítka podobného typu jako na Obr. 12. Position určuje, jak má být popis umís-

těn vzhledem k měřítkové linii. V úvahu nejčastěji připadá možnost above bar. Pomocí hodnoty Gap 

určíme vertikální odsazení číselných hodnot od měřítkové linie. 

V rámečku Marks můžeme ovlivnit vzhled příčných čárek. Frequency a Position mají stejný vý-

znam jako u předchozího rámečku, Division Height a Subdivison Height udávají délku příčných čárek 

hlavního, resp. vedlejšího dělení. Klepnutím na tlačítko Symbol lze pak nastavit vlastnosti linie tvořící 

příčné čárky. 

Na záložce Format (Obr. 21) pak lze v rámečku Text nastavit vlastnosti písma, které bude použito 

pro číselné hodnoty (přímo v okně font, velikost a barvu, klepnutím na Symbol pak další vlastnosti 

textu). V rámečku Bar lze vybrat barvu a po klepnutí na Symbol i další vlastnosti měřítkové linie. Ko-

nečně v rámečku Style lze dodatečně přepínat mezi předdefinovanými typy měřítka, mezi nimiž jsme 

vybírali v prvním kroku. Je zřejmé, že parametrů, které lze při návrhu grafického měřítka nastavit, je 

velké množství. Jako výhodné se proto jeví, připravit si vlastní styly měřítek a v rámci Style je uložit 

a opakovaně používat. 
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Obr. 21. Dialogové okno Scale Line Properties, záložka Format. 

 

Číselné a textové měřítko pro aktuálně vybraný datový rámec vložíme pomocí Insert > Scale Text. 

Tato volba opět spustí průvodce, kde si v okně Scale Text Selector vybereme měřítko nejlépe odpoví-

dající našim představám a volbu potvrdíme. Tím se měřítko vloží. Klepnutím pravým tlačítkem 

na měřítko a volbou Properties otevřeme dialogové okno Scale Text Properties (Obr. 22), kde lze 

vlastnosti měřítka upravovat. 
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Obr. 22. Dialogové okno Scale Text Properties pro číselné měřítko. 

 

V záložce Scale Text můžeme v rámečku Style vybírat mezi měřítkem číselným (Absolute) 

a textovým (Relative). V případě číselného měřítka lze níže v rámečku Format v poli Separator zadat 

oddělovač. Výchozí oddělovač je dvojtečka, okolo které nejsou mezery. Chceme-li tedy číselné měřít-

ko typograficky správně, zadáme do pole Separator řetězec mezera dvojtečka mezera. Výslednou 

podobu číselného měřítka pak vidíme v horní části okna v rámečku Preview. 

V případě textového měřítka vyplníme jeho formát, kdy v rámečku Format specifikujeme jednot-

ky stránky (Page Units) a jejich popis (Label), podobně pak jednotky v souřadnicovém systému mapy 

(Map Units) a jejich popis (Label). Mezi těmito údaji pak bude hodnota z pole Separator, kam lze za-

dat na jazyce nezávislý znak =, případně pro mapu v češtině napsat například text odpovídá. 
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Obr. 23. Dialogové okno Scale Text Properties pro slovní měřítko. 

 

Na kartě Format pak lze v rámečku Text nastavit vlastnosti písma, které bude použito pro číselné 

hodnoty (přímo v okně font, velikost a barvu, klepnutím na Symbol pak další vlastnosti textu). 

V rámečku Style lze pak přepínat mezi předdefinovanými typy měřítka, mezi nimiž jsme vybírali 

v prvním kroku. 

Číselné, grafické i textové měřítko se mění podle aktuálního pohledu na data v příslušném dato-

vém rámci. Pokud tedy mapu přiblížíme, měřítko se automaticky přepočítá. Podobně jako legendu lze 

měřítko převést na grafiku klepnutím pravým tlačítkem myši do prostoru měřítka a volbou Convert To 

Graphics. Tím se vazba na datový rámec ztratí a při přibližování a oddalování pohledu se již měřítko 

měnit nebude. Pokud od začátku měřítko vytvářené mapy víme a neplánujeme ho měnit, je jistě jed-

nodušší číselné a textové měřítko vložit do mapy jako obyčejný text (viz dále). 

Směrovka 

Směrovku pro aktuálně vybraný datový rámec vložíme do mapy pomocí Insert > North Arrow. Tato 

volba opět spustí průvodce, kde si v okně North Arrow Selector vybereme směrovku nejlépe odpoví-

dající našim představám a volbu potvrdíme. Tím se směrovka vloží. Klepnutím pravým tlačítkem 

na měřítko a volbou Properties otevřeme dialogové okno North Arrow Properties (Obr. 24), kde lze 

v záložce North Arrow vlastnosti směrovky upravit. 
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Obr. 24. Dialogové okno North Arrow Properties. 

 

V rámečku Angle v rozevíracím seznamu Align To vybereme, zda má být směrovka natočena pod-

le rotace datového rámce (Data Frame Rotation) nebo má směřovat k severu (True North). Výsledné 

natočení se objeví v Calculated Angle. Pomocí Calibration Angle lze zadat úhel natočení ručně, což 

může mít význam například v situaci, kdy chceme, aby směrovka ukazovala k magnetickému severu 

a nikoliv k severu ve smyslu obrazu severního pólu příslušného kartografického zobrazení. 

V záložce Marker vybereme konkrétní symbol použitý pro směrovku. Symboly pro jednotlivé 

směrovky jsou uloženy jako jednotlivá písmena (tzv. glyfy) fontu, přičemž výchozím fontem programu 

ArcGIS je ESRI North. Jeho nevýhodou je, že použité symboly pro světové strany jsou označené an-

glicky. Tvoříme-li mapu v češtině, musíme se tedy spokojit buď se směrovkou bez popisu, nebo si 

nainstalovat font s českými směrovkami. Příslušný font následně vybereme, v rámci něj zvolíme klep-

nutím na Character konkrétní znak (směrovku), dále zadáme její velikost, barvu a po klepnutí 

na tlačítko Symbol případné další vlastnosti. Výslednou podobu směrovky vidíme v rámečku Preview. 

Font s českými směrovkami (ESRI Czech North), jehož autorem je Jan D. Bláha z ústecké univerzi-

ty, je ke stažení jako příloha tohoto listu, nebo na webu autora [7]. 

V teoretické části tohoto listu jsme si vysvětlili, že zejména u map malého měřítka je lepším způ-

sobem pro vyjádření směru k severu zeměpisná síť. Pokud chceme do mapy vložit zeměpisnou síť, 

vybereme příslušný datový rámec, klepneme na něj v zobrazení výkresu pravým tlačítkem myši, zvo-

líme možnost Properties a přepneme se na záložku Grids. Zde můžeme zeměpisnou síť vytvořit (po-

mocí průvodce spuštěného klepnutím na New Grid), případně již existující síť vymazat (klepnutím 

na Remove Grid) či měnit její vlastnosti (pomocí tlačítka Properties). Sítí lze vytvořit v rámci jednoho 

datového rámce více. Vzhledem k tomu, že zeměpisná síť není mimorámový údaj, nejsou v tomto 

listu tyto volby popsány detailně.  
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Při vytváření sítě v prvním kroku průvodce je potřeba zvolit možnost Graticule: divides map by meridians 

and parallels. V dalších krocích se intuitivním způsobem zadají další parametry pro tvorbu sítě, které lze po je-

jím vytvoření následně změnit.  

Pro úplnost zmíníme ještě alternativní způsob vytvoření zeměpisné sítě, který je potřeba v případě, že výchozí 

přepočet zeměpisných souřadnic na dané zobrazení vykazuje polohové nepřesnosti (například zobrazení ze-

měpisné sítě v datovém rámci v Křovákově zobrazení), případě v situaci, kdy potřebujeme mít lepší kontrolu 

nad umisťováním popisu sítě nebo vynecháváním jejích částí (například u tzv. ostrovních map). Postupovat lze 

následovně: 

– vytvoříme zeměpisnou síť v požadovaném intervalu v zeměpisných souřadnicích (tj. zobrazení s EPSG kó-

dem 4326) pomocí funkce Create Fishnet. Důležité je zvolit typ výstupní geometrie (Geometry Type) 

POLYLINE, 

– přidáme liniím atribut popisující jejich zeměpisnou šířku, resp. délku, buď manuálně, nebo s využitím 

vlastností jejich geometrie, například souřadnic prvního a posledního bodu, 

– zahustíme zeměpisnou síť pomocí funkce Densify s ohledem na měřítko výsledné mapy a její souřadnico-

vý systém. Tento krok je přidán z toho důvodu, aby po převodu do souřadnicového systému mapy nedo-

šlo k příliš velké odchylce obrazu poledníku/rovnoběžky z důvodu velké vzdálenosti mezi body, jimiž je 

tvořena, 

– převedeme zeměpisnou síť do souřadnicového systému mapy pomocí funkce Project, s tím, že vybereme 

správný typ transformace (například pro Křovákovo zobrazení tu variantu, která končí _1), 

– výslednou vrstvu standardními editačními nástroji upravíme podle svých představ (například odmazání 

částí mimo mapové pole u ostrovní mapy),  

– výsledné linie na základě příslušného atributu popíšeme, buď automaticky, případně s využitím konverze 

popisu na anotace a jejich manuálního doladění (viz výukový list Popis na mapách). 
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Text a grafika 

Text do mapy vložíme pomocí volby Insert > Text. Vytvoří se tím textové pole, v němž je umístěn text 

Text. Klepnutím pravým tlačítkem myši do prostoru tohoto pole a volbou Properties můžeme 

na záložce Text upravit vlastní text (v poli Text) a měnit některé jeho základní vlastnosti (další vlast-

nosti jsou dostupné po klepnutí na tlačítko Symbol). Podstatné je, že nastavené hodnoty platí 

pro celý text. Pokud chceme mít nějakou část textu naformátovanou odlišným způsobem, lze použít 

formátovací značky. Například chceme-li mít část textu kurzívou, vloží se příslušná část textu mezi 

značky <ITA> a </ITA>. Pro horní a dolní index se užívá tagů <SUP> a </SUP>, resp. <SUB> a </SUB>. 

Princip značek je podobný jako u HTML tagů, byť mají odlišnou syntaxi. Přehled dostupných značek se 

objeví na stránce s nápovědou po klepnutí na odkaz About formatting text. 

 

  

 

Uvedené textové pole je vhodné pouze pro krátké texty, protože je nutné text manuálně zalamo-

vat (tedy vložit znak Enter do pole Text). To je extrémně nepohodlné, zvlášť v situaci, kdy změníme 

velikost písma a potřebovali bychom text zalámat znovu a jinak. Pro rozsáhlejší texty proto může být 

vhodné využít možností, které nabízí panel Draw. Ten vyvoláme klepnutím pravým tlačítkem myši 

na libovolné místo záhlaví programu ArcMap a zaškrtnutím možnosti Draw. 
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Panel nabízí možnost umístit text také na křivku (Splined Text), do polygonu (Polygon Text), ob-

délníku (Rectangle Text) či kruhu (Circle Text), v nichž se text nechová jako řetězový, nýbrž jako od-

stavcový. Navíc oproti výše popsanému je tak ve vlastnostech textu na záložce Columns and Margins 

možné definovat v rámečku Columns rozdělení textu do více sloupců (bude jich podle Number 

of columns a mezi nimi mezera o velikosti Gap between columns) a vnitřní okraj Margin around text 

(tedy vzdálenost textu od okraje polygonu, obdélníku či kruhu). Tento typ objektu je použitelný 

i pro rozsáhlejší texty, protože k zalamování dochází automaticky podle definované oblasti a okraje. 

I zde lze používat formátovací značky popsané výše. Na záložce Frame lze pak definovat případnou 

výplň a barvu a styl hranice okolo textu, zmíněnou u legendy. Tato možnost je ostatně dostupná 

pro všechny objekty v layoutu mapy, zde ale může být její použití zvláště užitečné. 

Název mapy, resp. titul, vložíme pomocí Insert > Title. ArcMap nás vyzve k zadání titulu 

a následně vytvoří příslušný objekt s textem. Název je speciální textové pole, které má význam 

zejména při automatizované tvorbě map s využitím Data Driven Pages nebo skriptů. Nepotřebujeme-

li těchto možností využívat, je z pohledu vzhledu výsledné mapy je jedno, zda vložíme název mapy 

pomocí Text nebo pomocí Title. 

Další grafické objekty vkládáme pomocí Insert > Picture nebo Insert > Object, případně přes 

schránku (Ctrl+C ve zdrojové aplikaci, Ctrl+V, případně Edit > Paste Special v ArcMap). Pro jednodušší 

vektorovou grafiku (linie, obdélníky atd.) lze využít také kreslicí nástroje dostupné v panelu Draw 

zmíněném výše. 

 

 

S jednotlivými objekty v layoutu mapy, jak grafickými, tak s mapovým polem či ostatními mimo-

rámovými údaji, lze pracovat také jako s celkem. Pokud označíme několik objektů klepnutím myši 

s přidržením Shift nebo klepnutím a táhnutím, lze s nimi pracovat podobným způsobem jako 
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v grafických vektorových editorech. Dostupné možnosti se objeví po klepnutí pravým tlačítkem myši 

do plochy vybraných objektů. 

 

Objekty lze tímto způsobem seskupovat (Group) a jejich seskupení zrušit (Ungroup), provádět 

s některými z nich grafické operace (Graphic Operation), přenášet je do popředí nebo do pozadí (Or-

der), posouvat (Nudge), zarovnávat vůči sobě i vůči okrajům stránky (Align), rozmisťovat (Distribute) 

či natáčet o násobky 90° (Rotate or Flip). Lze využít také zarovnání k vodicím linkám, které vytvoříme 

klepnutím do vodorovného nebo svislého pravítka v horní, resp. levé části obrazovky. Všechny tyto 

nástroje umožní vytvořit precizní layout mapy zejména z pohledu zarovnání a rozmístění všech kom-

pozičních prvků. 

 

 

  

Je dobré si uvědomit, že ArcMap nenabízí možnosti, které jsou dostupné ve specializovaných 

programech pro zpracování vektorové grafiky, jako jsou Adobe Illustrator, Corel Draw či Inkscape. 

V praxi se proto v aplikaci ArcMap řeší pouze část tvorby mapového díla (zejména obsah mapového 

pole), mezivýsledek se následně vyexportuje do formátu PDF a v pohodlí grafického programu se pak 

řeší grafická část tvorby mapového díla, k níž lze řadit i některé mimorámové údaje. Popsané funkce 

v aplikaci ArcMap lze s výhodou použít v případě, kdy nám stačí jednoduché formátování 
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a nekomplikovaná grafika a použití specializovaného grafického programu by byla zbytečná práce 

navíc. Při přítomnosti složitější grafiky navíc bývají problémy při exportu mapy z ArcMap do PDF. 

Vedlejší mapové pole 

Další mapová pole vložíme na stránku pomocí volby Insert > Data Frame. Po klepnutí na tuto možnost 

se objeví nový datový rámec v layoutu mapy a vlevo v Table Of Contents nová položka. V zobrazení 

výkresu následně upravíme velikost a umístění datového rámce na výsledné mapě. Tímto způsobem 

lze vložit v rámci jedné stránky několik mapových polí. Vytvořený datový rámec je vhodné přejmeno-

vat, aby bylo zřejmé, co které mapové pole zachycuje. Přejmenování lze provést v Table Of Contents 

vybráním příslušného datového rámce, klepnutím na F2, napsáním nového názvu a potvrzením klá-

vesou Enter.  

Aktuálně vybraný (aktivní) datový rámec je zvýrazněn v Table Of Contents tučným písmem. Klep-

nutím pravým tlačítkem na název datového rámce v Table Of Contents můžeme neaktivní datový 

rámec aktivovat (volbou Activate). Přepnutím ze zobrazení výkresu (Layout View) do zobrazení dat 

(Data View) pracujeme vždy s aktivním datovým rámcem. Aktivního datového rámce se týká 

i vkládání některých mimorámových údajů (např. legendy, měřítka, směrovky). 
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Souhrn 

Mimorámové údaje tvoří důležitou součást mapy. Na každé mapě by se kromě vlastního mapového 

pole měly vyskytovat také název, legenda, měřítko a tiráž, ve většině případů také směrovka nebo 

zeměpisná síť. Rozmístění údajů na stránce je třeba dobře rozmyslet. 

Pro jednotlivé kompoziční prvky platí určitá kartografická pravidla, která sice nelze dogmaticky 

vymáhat, nicméně nesou v sobě dlouhodobé praktické zkušenosti kartografů a dalších tvůrců map. 

Proto je vhodné tato pravidla dodržovat. Mapu lze doplnit dalšími textovými a grafickými údaji. Apli-

kace ArcMap umožňuje všechny mimorámové údaje velmi snadno vytvářet a následně upravovat. 

Pro finalizaci složitějších map může být nicméně užitečné použít program pro práci s vektorovou gra-

fikou, který v některých ohledech nabízí pohodlnější práci a větší tvůrčí svobodu. 
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